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Introduction 
MAGic User’s Guide 

About This Book 
The MAGic User’s Guide teaches you to use and customize MAGic’s 
magnification and speech capabilities to fit your personal needs. The 
first chapter, the Quick Start Guide, gives you the basics to get up and 
running with MAGic. Following the Quick Start Guide is a more complete 
guide to all of MAGic’s features. Finally you will find appendices that 
include perforated keystroke reference cards. However you decide to use 
this book, we will guide you to a more productive computing experience 
with magnification and speech. 

Items Checklist 
In your MAGic package, you should find the following items. If you 
discover damaged or missing items, please contact your retailer. 

•	 CD Wallet containing one program CD-ROM, and either an 

authorization or update diskette 


•	 Registration diskette 

•	 MAGic User’s Guide 

Documentation Conventions 
In the MAGic User’s Guide we will refer to various commands, menu 
options, and other selections. To make reading this guide as simple as 
possible, we have included a sample of the following conventions.  

A hot key is a combination of keys pressed on the keyboard, which will 
invoke the same response regardless of the application you are 
currently using. A hot key can be a single key on the keyboard, but more 
commonly it is several keys pressed in combination. For example, 
ALT+CTRL+M requires you to press all three keys simultaneously.  
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Alternatively, shortcut keys invoke a different action depending on the 
application in which you are currently working. Shortcut keys also can be 
one key, or multiple keys pressed in combination. Shortcut keys may 
also require you to press a sequence of keys, such as ALT+F, O. This 
requires that you press the ALT key and the F key, release them, and 
then press the letter O key. These hot keys and shortcut keys will 
appear in bold text throughout the User’s Guide. 
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Chapter 1 
Quick Start Guide 

Welcome to MAGic 
MAGic is a software solution ideally suited for vision-impaired computer 
users, or anyone who spends extended periods of time in front of a 
computer screen. 

In addition to magnifying your computer screen, MAGic also reads your 
programs and documents clearly and audibly. MAGic synchronizes 
magnified print with speech. MAGic also highlights words and lines as it 
speaks them. 

You see and hear what you are typing. You see and hear menus, 
buttons, and other window controls. MAGic lets you enlarge Microsoft 
Windows application screens, dialogs, and windows from 2 to 16 times 
their normal size on your PC. MAGic also provides several different 
magnified viewing options.  

MAGic tracks the movements of one or more objects, such as the 
mouse, menus, dialogs, and so on. Screen locators give you a visual 
reference of magnified views in relationship to the unmagnified portion 
of your screen.  

The MAGic multi-directional panning system gives you complete control 
during screen review with adjustable speed, direction, stop and start, 
and screen navigation controls. 

For easier viewing, you can reverse screen colors and customize the 
shape and color of your mouse pointer. 

If you have a magnification only version of MAGic, and want to upgrade 
to a speech version, contact Freedom Scientific Sales. 
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Choose to run the Automatic or Guided installation of MAGic. The 
Automatic installation assumes that you want to install all languages, 
and you approve of the default location where MAGic installs on your 
hard drive. If you want to specify which languages to install and/or 
where MAGic is stored on your computer, use the Guided installation.   

Instructions for installing MAGic on a Network can be found in the 
online help system. 

Authorize MAGic 
The authorization key contains the information your computer needs to 
run MAGic. MAGic prompts you for either an authorization disk or an 
update disk, if you received one. Follow the instructions that appear on 
the screen to complete your authorization of MAGic.  

If you do not have a current authorization key, you can run MAGic for a 
total of 150 hours in demonstration mode. After the demonstration trial 
period elapses, you will need a current authorization key if you want to 
continue using the software. 

For more information about MAGic Authorization, see Appendix A, Using 
HJAuth. 

Register MAGic 

Initial Registration 
MAGic prompts you to register the first time you run the program. 
MAGic will only prompt you to register if you have not previously 
registered. MAGic lets you choose to register now or later. If you choose 
to register later, MAGic will prompt you to register each time you launch 
the program.  

If you choose to register later, and you check the checkbox, “Do not 
show this dialog,” you need to manually register later. To access the 
registration dialog later, select Register MAGic from the Help menu.  

Note: If you are running a site, district, or enterprise license version 
of MAGic, you will not be prompted for registration. 
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We recommend you register MAGic as soon as you start the software. 
After you choose the option to register now, fill in the edit fields. Those 
preceded with an asterisk are required fields. Use the TAB key to move 
around the dialog box, select Next to move to the next page of the 
registration. Use the Back button if you need to move backward through 
the registration to change any of your information. Use the RIGHT and 
LEFT ARROW keys to move through the options in the combo boxes.   

On the last screen of the registration, a combo box asks you to select a 
method to send your information to Freedom Scientific. Choose to send 
your information via the Internet using your Internet connection, if you 
have one; or save the information to a floppy disk and mail it to 
Freedom Scientific. If you choose to send it via traditional mail, MAGic 
prompts you to enter the registration disk, which is provided with the 
software. If you send your registration via e-mail, you will receive a 
dialog box thanking you for your registration information.  

Changing Your Registration 

If you need to change your registration information, such as your 
address or phone number, select Update Registration from the Help 
menu. The same series of dialog boxes appear that you used for your 
initial registration. Change the necessary information, and send it again. 

Uninstalling MAGic 
To uninstall MAGic go to the Program menu and select the Uninstall 
MAGic option in the MAGic submenu. 

Getting Started 

Opening MAGic 
MAGic gives you a variety of ways to launch the program.  

•	 Press the hot key, ALT+CTRL+M, which is automatically assigned 
when you install MAGic. 

•	 Double-click the MAGic icon on your desktop.  

•	 Go to the Start menu, select Programs, and then select MAGic, and 
select MAGic from the MAGic submenu. 
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After you open MAGic for the first time, you can set MAGic to begin 
running when Windows starts. To make this selection, choose Run 
MAGic at Startup from the File menu. 

Closing MAGic 
Close MAGic like any other Windows application by pressing ALT+F4, 
point the mouse and left click on the X in the top right hand corner of 
the window, or select Exit from the File menu. As you exit, MAGic 
prompts you to save any settings that you changed. MAGic also confirms 
that you want to close the program. 

Overview of MAGic for New Users 
Start MAGic by pressing CTRL+SHIFT+M or by double-clicking the MAGic 
program icon on your Windows desktop. You can also start MAGic by 
clicking the Start menu and choosing Programs, MAGic, MAGic. 

When you first start MAGic, your screen is displayed in 2X magnification 
using the Full view. Speech will also be enabled. You can change the 
magnification level, magnified view, speech, and many other options by 
using the MAGic user interface. 

The user interface is a small window that appears in approximately the 
center of your display. This window allows you to control all aspects of 
MAGic and contains the magnification and speech buttons in addition to 
the MAGic menu and title bars.  

For more information on the MAGic user interface, please refer to 
Chapter 3 User Interface . 

Magnification and Speech Buttons 
One of the first things you will notice about the user interface is the 
rows of blue and orange buttons. The blue buttons control magnification 
features while the orange buttons control speech. Below are brief 
descriptions of each button. 
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Button Function 

Click the Magnification button to enable or disable 
magnification. 

The current magnification level can be adjusted with 
the two Magnification Level buttons.  

Click the Mouse Enhancements button to 
enable/disable mouse enhancements. Mouse 
enhancements change the appearance of your mouse 
pointer. 

Click the Inverse Colors button to enable/disable the 
Invert Colors feature. This features inverts the colors 
displayed on your screen. 

Click the Locator button to enable/disable the Locator 
function. The Locator function allows you to find items 
on your screen.  

Click the Smoothing button to enable/disable 
smoothing. This feature smoothes the appearance of 
jagged letters in a magnified state.  

The Resize View button allows you to change the 
dimensions of your magnified view. 

Select your preferred magnified view from the 
Magnified Views combo box. 

Click the Speech button to enable or disable speech. 

Click the Mouse Echo button to toggle the mouse echo 
feature on and off. The mouse echo feature enables 
MAGic to read text that you point at with the mouse. 

Click the Typing Echo button to enable or disable the 
typing echo. If typing echo is enabled, MAGic 
announces the words or characters you type. 
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MAGic Menus 
Located above these buttons is the menu bar. The menu bar allows you 
to customize speech, magnification, and your keyboard. You can also 
view help information and perform other functions. Each menu is 
described below. Click the links to learn more about each menu. 

Menu Purpose 

File The File menu allows you to save your settings and 
restore the original Freedom Scientific settings. You 
can also use this menu to exit MAGic and 
automatically run MAGic when your PC starts. 

Magnification The Magnification menu allows you to customize how 
you view your screen with MAGic. You can also 
change mouse options, panning settings, view 
properties and more. 

Speech You can customize MAGic’s speech components to fit 
your particular needs. The Speech menu allows you 
to customize how you hear MAGic. 

Keyboard The Keyboard menu allows you to customize how you 
use your PC's keyboard with MAGic. You can re­
assign the MAGic Key to a different key, manage 
shortcut keys, and more. 

Help The Help menu provides you with detailed help 
information for the various MAGic functions and 
options. You can also view information on the newest 
features for this release and see your current MAGic 
version. 
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What’s This? Help 

MAGic’s What’s This? Help is context-sensitive help that you can use as 
a reference when working with MAGic’s user interface or dialog boxes. 
Press SHIFT+F1 on any button on the user interface, or control in a 
dialog box to see a brief description of the purpose of the control and 
how to use it. 

MAGic Users’ Guide 

We provide you with the content of the MAGic online help system in the 
MAGic User’s Guide, which is printed in large text for easier reading. The 
manual contains the Quick Start Guide to get you started, followed by 
detailed description of MAGic’s features, and also pull out reference 
cards. 

Technical Support 

If you do not find the answers to questions or problems that you have, 
contact Freedom Scientific Technical Support, (727) 803-8600. 

About MAGic 

Select About MAGic from the Help menu on the MAGic user interface to 
view the version number of MAGic you are currently running.  
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Chapter 2 
Navigating MAGic 

Use Your Mouse and Your Keyboard 
With MAGic, you can use both your mouse and your keyboard to access 
most features. You decide what is best for you. Many people use a 
combination of the two. The MAGic documentation gives you 
information on how to perform actions with both the keyboard and the 
mouse. For example, you can either press ALT+F to access the file 
menu, or you can point and click the word File with the mouse. 

Using the Keyboard with MAGic 

The MAGic Key 
When you use the keyboard in MAGic, the most important thing to know 
is the MAGic Key. The default MAGic Key is the CAPS LOCK key on your 
keyboard. Using the MAGic Key in combination with other keys activates 
a MAGic command if one is assigned, otherwise it will pass the key 
combination through to the application. Pressing the MAGic Key by itself 
and releasing it will not carry out any action. You can specify what key 
you use for your MAGic Key in the MAGic Key dialog, which is activated 
from the Keyboard menu. Your choices include:  Extended Insert (found 
on the six pack), Num Pad Insert, Either Insert, or Scroll Lock (the key 
just above Home). 

Pass the MAGic Key Through 

If your MAGic Key is set to the default of CAPS LOCK, how do you use 
your CAPS LOCK key as usual? 

Press the CAPS LOCK key twice quickly, and Caps Lock will turn on. To 
turn off Caps Lock, again press the key twice quickly. Use this double 
key press to pass through any of the MAGic Keys that you use. For 
instance, if you select INSERT as your MAGic Key, press the INSERT key 
twice to use the actual insert function.  

16 



Pass Through Key Command 

If you have an application that uses the same keystroke combination as 
one assigned to MAGic, you can pass the keystroke combination through 
to the application, so it will not function as a MAGic keystroke in that 
instance. 

Press MAGic Key+3 (on the number row), and then press the keystroke 
you want to use in the application. Use the pass through command for 
any key combination that is used in MAGic and in other applications.  

With MAGic, you can customize all of your keystrokes in the Keyboard 
Assignments dialog, activated from the Keyboard menu. If you specify 
certain keystrokes for use in MAGic, you may need to use these 
keystrokes in other applications. Keep the pass through command of 
MAGic Key+3 in mind when you customize keystrokes. 

Customizing the Keyboard 
The Keyboard menu allows you to customize how you use your PC's 
keyboard with MAGic. The Keyboard menu allows you to re-assign the 
MAGic Key to a different key, manage shortcut keys, and differentiate 
between the left and right ALT, SHIFT, and CTRL keys. The Keyboard 
menu provides the following options: 

•	 Choose MAGic Key from the Keyboard menu to change which key is 
assigned to the MAGic Key. You can assign the MAGic Key to either 
the CAPS LOCK key, extended INSERT key (found on the six pack), 
NUM PAD INSERT key, either INSERT key, or the SCROLL LOCK key 
(located just above HOME). 

•	 Choose Keyboard Assignments from the Keyboard menu to view the 
current hot keys assigned to actions, assign different hot keys, 
remove hot keys, or restore the hot keys to the default settings.  

•	 Choose Options from the Keyboard menu to differentiate between the 
left or right CTRL, ALT, and SHIFT keys for hot key combinations. 

Refer to Chapter 6 Keyboard for detailed information on these 

commands. 
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Using the Mouse with MAGic 

Point & Click 
With MAGic you don’t have to learn keystrokes to perform actions. You 
can use the mouse to point at items on the user interface, and click the 
buttons to activate features. For example, to invert screen colors, just 
point at the Inverse Colors button, click with the left mouse button, and 
the colors on your screen change. 

If you are not sure how to activate a feature, use your mouse to open 
the menus and find the feature you need. 

Left Click vs. Right Click 
The left mouse button is the more commonly used mouse button, 
because it activates buttons and menus. Alternatively, the right mouse 
button provides useful shortcuts to many items found under MAGic’s 
menus. 

Right click on many of the buttons on the user interface to see a context 
menu. Depending on where you right click on the user interface, the 
menus change. Use your right mouse button to access the most 
common features associated with the buttons on the MAGic user 
interface. 

If you are not a mouse user, you can activate context menus with the 
Application key on the keyboard. Locate the Application key just to the 
left of the right CTRL key in the bottom row on your main keypad. Use 
the TAB key to place the focus on the button that you want to see the 
context menu for, and press the Application key to see the menu. Then 
use the UP and DOWN ARROWS to move through the menu choices. 
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Menu Bar 
The MAGic menu bar contains five menu titles: File, Magnification, 
Speech, Keyboard, and Help. 

To open these menus press ALT and the underlined letter, for example, 
press ALT+F to open the File menu. 

The File menu contains four items: 

•	 Run MAGic at Startup – When checked, MAGic runs automatically 
after you log on to your computer. 

•	 Save Settings – When you change options found in the Magnification 
and Speech menus, select Save Settings to store your preferences for 
the next time you run MAGic.  

•	 Restore Factory Settings – Select this menu item to reset MAGic 
options to the state they were in when you installed MAGic. Selecting 
this option returns all features to the original settings, except hot 
keys that you customize. Press the Restore Defaults button in the 
Keyboard Assignments dialog to revert all hot keys to their original 
configurations. 

•	 Exit – Exiting MAGic closes the program. If you have made any 
changes, MAGic prompts you to save those settings upon exiting the 
program. 

Find information about the Magnification and Speech menus in the 
Chapters 4 and 5. 

Quick Access Window 
MAGic’s Quick Access Window provides controls to help you easily 
access the main MAGic features. Use the buttons on the user interface 
to control both magnification and speech. Left click the button to 
activate the feature, and right click the button to see a context menu for 
some of the buttons. Only some buttons contain context menus. 
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Figure 1 Quick Access Window 

The Magnification Buttons 
Use the blue buttons on the MAGic user-interface to control 
magnification. 

Magnification Button 


Use this button to enable or disable magnification. 


When MAGic opens, the screen is magnified two times its normal size. 
Press the magnification button to turn off magnification. If the M on the 
magnification button is animated, then magnification is turned off. 

Hot Keys 

Enable or Disable MAGic Key+DELETE 
Magnification 

Magnification Level Button 

Increase or Decrease Magnification Level with this button. 

The Magnification Level button is actually two buttons. The upper 
button, with the upward arrow image, increases the magnification level, 
while the lower button, with the downward arrow image, decreases the 
magnification level. The number between the two buttons shows the 
current magnification level. The default level of magnification is 2x (2x 
is equivalent to two times the normal screen display). If you press the 
TAB key to move into the area where the number appears, use your UP 
and DOWN ARROW keys to increase or decrease magnification. 
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It is possible to change the magnification level to 1. This will prevent 
the M button from rotating and provide access to some magnification 
features, such as using the locator.  

Hot Keys 

Increase Magnification MAGic Key+NUM PAD PLUS 
or CTRL+EQUALS 

Decrease Magnification MAGic Key+NUM PAD MINUS 
or CTRL+HYPHEN 

Mouse Enhancements Button 

Change the appearance of your cursor with this button. 

After you change the properties of your Magnified View Mouse and the 
Unmagnified View Mouse, press the Mouse Enhancement button to 
enable the changes. Press the button again to return to the standard 
mouse. 

Right click the Mouse Enhancement button to quickly access the 
Magnified Mouse, Unmagnified Mouse, or Navigation Options tabs of 
the Mouse Settings dialog. 

Locator Button 

Activate the Locator with this button. 

To find items on your screen, press the Locator button. Move the Locator 
with your mouse or your arrow keys. Change the properties of the 
Locator with the Locator Properties dialog, which you can access from 
the Magnification menu. Also you can right click the Locator button to 
change the Style and Border of your Locator. 
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Hot Keys 

Enable Locator Mode MAGic Key+F10 

Disable Locator Mode ESC 

Inverse Colors Button 

Change your display colors with this button. 

Press the Inverse Colors button to invert the colors of the display. Press 
it again to toggle the colors back to normal. Right click the Inverse 
Colors button to choose what views should be inverted when Inverse 
Colors is enabled. You may choose to invert only the Magnified View, 
only the Unmagnified View, or All Views. 

Hot Keys 

Invert Colors MAGic Key+F12 

Smoothing Button 

Toggle Smoothing on or off with this button. 

Press the Smoothing button to smooth the appearance of jagged letters 
in a magnified state. Press the button again to turn Smoothing off. 

Resize View Button 

When working in Split, Overlay, or Lens Views, use the Resize View 
Button to turn on the Windows Tool. This appears as a pointer used to 
resize or move the view. 
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You must be in the Split, Overlay, or Lens view, and magnification must 
be active to use the Resize View button. When the Resize View button is 
available it appears blue. If it is gray, you need to turn on magnification, 
by pressing the Magnification button on the MAGic user-interface. After 
you press the Resize View button, notice that the cursor changes shape, 
and that MAGic automatically minimizes the user-interface. The shape 
of the mouse indicates in which direction you can click and drag your 
mouse to move or resize your view. 

If the pointer appears as an X, like above, it is not positioned over the 
view or one its borders. The X indicates that from this position the view 
cannot be resized or moved. 

A bi-directional cross indicates the ability to move the view to a 
different location on your screen. Click the view, and while holding the 
mouse button down drag the view to another location. Split view only 
moves to the top, bottom, left, or right edge of your screen, while you 
can move Overlay to any location on your screen. 

A vertical pointer indicates that resizing will occur in a vertical direction, 
larger or smaller. 

A horizontal pointer indicates that resizing will occur in a horizontal 
direction, either larger or smaller. 
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A diagonal pointer indicates that resizing will occur in both vertical and 
horizontal directions. MAGic only exhibits the diagonal mouse when you 
position the mouse over the corner of the view. The diagonal pointer is 
only available for the Overlay and Lens views. 

Magnified Views Combo Box 

Select your favorite magnified view from the combo box on the MAGic 
user-interface. 

You can select Full, Lens, Overlay, or Split for your magnified view. Full 
magnifies the entire screen, while each of the others only magnifies a 
portion of your screen at a time. Right click the Magnified Views Combo 
Box to quickly access the properties for the Split, Lens, or Overlay views. 

The Speech Buttons 
The three orange buttons at the bottom right of the MAGic user-
interface allow you quick access to MAGic’s speech capabilities. From 
here, you can enable or disable Speech, Mouse Echo, and Typing Echo. 

Note: 	 When a button is pressed or enabled the background color of 
the button will have a checkerboard pattern. This will cause 
the enabled buttons to appear lighter in color. 

Speech Button 

Click this button to enable or disable speech. 

If the button appears with the mouth opened, like this one, then Speech 
is enabled. 

If the button appears with the mouth closed, then Speech is disabled.  

Right click the Speech button to quickly access the Voices dialog. 
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Hot Keys 

Toggle Speech MAGic Key+SHIFT 

Mouse Echo Button 

Click this button to toggle the Mouse Echo. 

If the button appears with white lines to the right, the Mouse Echo is 
turned off. 

If the button appears with black lines to the right, the Mouse Echo is 
turned on.  

To set Mouse Echo to announce lines or words, right click the button and 
make your selection from the context menu. You can also set mouse 
movement to stop speech from this context menu. 

Hot Keys 

Mouse Echo Toggle MAGic Key+M 

Typing Echo Button 

Click this button to toggle the Typing Echo on and off. 

If the Typing Echo button appears to have white lines extending from 
the right side, the Typing Echo is turned off. 

If the Typing Echo button has black lines extending from the right side, 
then the Typing Echo is turned on. To specify the typing echo to words 
or characters, you need to activate the Typing Echo dialog from the 
Speech Menu, or right click and choose Automatically Speak. Choosing 
Keystrokes to Echo lets you modify how much MAGic echoes back to 
you. 
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Chapter 4 
Magnification 

Magnification Features 
With MAGic’s extensive magnification features, you can customize your 
display to fit your low vision needs. 

The Magnification menu, found on the menu bar, contains all of the 
controls to change the appearance of your display. 

The first item on the Magnification menu, Enable Magnification, lets you 
activate or deactivate magnification. If the menu item appears with a 
checkmark next to it, magnification is enabled. If there is no checkmark, 
magnification is disabled. 

Remember that the blue buttons on the user-interface allow you quick 
access to the basic magnification features. 

The Magnification Menu 

Display 
The Display dialog box, accessed from the Magnification menu, lets you 
control a variety of magnification features. 
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View 

The View combo box contains the choices, Full, Lens, Overlay, and Split. 

Full magnifies the entire screen.  

Lens opens a small rectangular window, which is magnified, while 
leaving the remaining desktop unmagnified. The Lens moves around the 
screen as you move your mouse or when the focus moves. 

Overlay creates a magnified window on the corner of the screen, while 
the rest of the screen remains unmagnified. This is similar to the Lens 
View, although the Overlay View does not move around the screen. 

Split allows you to see both an unmagnified view and a magnified one at 
the same time. The Split View opens a magnified window on part of your 
screen, but leaves the other part unmagnified as a reference. 

Views with Level 1 Magnification 

You can make the Lens, Overlay, and Split views active in all 
magnification levels, including 1x. Using these views with level 1 
magnification can be helpful, if you invert the colors of either the 
magnified or unmagnified view. You then have two images, one with 
normal colors, and one with inverted colors. 

Using these features in level 1 magnification is also helpful if you use 
the Lens view with Resize to Control turned on. Activate Resize to 
Control from the Lens page of the View Properties dialog box. Press the 
TAB key to move through items in a dialog, and you will see a border 
around the Lens view. You can customize the border to make the 
controls easy for you to see. 
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Magnification Level 

Press the UP or DOWN ARROW keys to increase or decrease the current 
magnification level. Magnification levels range from the same size as 
the normal display, all the way up to 16 times the size of the normal 
display. 

Vertical Stretch 

Vertical Stretch allows you to stretch the display to make images taller 
while maintaining the characters current width. 

Smooth Text 

Smoothing compensates for the stair-step effect, as screen objects get 
larger during magnification. Smoothing is on by default. You can turn 
Smoothing on or off with the Smoothing check box. 

Disable Screen Saver 

For those screen savers that do not work well with MAGic running, place 
a check in the Disable Screen Saver check box. When you close MAGic, 
the screen saver is automatically re-enabled. 

Mouse Settings 
From the Magnification menu, choose Mouse Settings to control the 
appearance of your mouse while in the magnified and unmagnified 
views. You can also set mouse navigation options. 

Any adjustments you make to the mouse enhancements will take effect 
when you enable mouse enhancements by clicking the Mouse 
Enhancements button on the MAGic User Interface. You can also select 
the Enable Enhancements check box to activate your changes. 

Note: Selecting the Enable Enhancements check box on either page 
of the Mouse Settings dialog selects the check box for both 
pages of the dialog. 
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Magnified Mouse 

This tab allows you to define mouse enhancements for the mouse 
pointer in magnified views. 

Enable Enhancements 


Select this check box to activate the enhancements you set in this 

dialog box. You can disable the mouse enhancements by clearing this 

check box or by clicking the Mouse Enhancements button on the MAGic

user interface. 


Extra Large 


Select this check box to increase the size of the mouse pointer to double 

the standard mouse pointer size. 


Enhancement Color


Select a color for your enhancements. MAGic uses this color for the 

pointer color (if you select the Enhancement Color option), crosshair 

enhancement, and bull’s eye enhancement. 


Pointer Color 


Select one of the following pointer color enhancements: 
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•	 Normal – Displays the enhanced mouse pointer using the default 
colors. This is typically white with a black border. 

•	 Reverse Image – Reverses the colors of the enhanced mouse pointer. 

•	 Invert Background – The enhanced mouse pointer becomes 
transparent with the background showing through with inversed 
colors, which increases contrast. The black border remains around the 
pointer. 

•	 Enhancement Color – The enhanced mouse pointer's color is changed 
to the color you select in the Enhancement Color field. 

Crosshair Enhancements 

Select one of the following crosshair enhancements: 

•	 None – No crosshair is shown. 

•	 Short Crosshair – Adds short vertical and horizontal crosshairs 
centered at the tip of the enhanced mouse pointer. 

•	 Long Crosshair – Adds vertical and horizontal crosshairs through the 
center of the 

Bull’s Eye Enhancements 

Select one of the following bull's eye enhancements: 

•	 None – Does not apply a bull’s eye to the enhanced mouse pointer. 

•	 Square – A square appears around the enhanced mouse pointer. 

•	 Circle – A circle appears around the enhanced mouse pointer. If you 
select this option, you will see some flickering as you move the 
mouse around the screen. 

Unmagnified View 

The options available on this tab are identical to the options described 
for the Magnified Mouse tab. 
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Navigation Options 


Tether-to-Display 

When this check box is checked, the mouse is "tethered," or attached, to 
the magnified display. As soon as you move the mouse, the mouse 
automatically snaps into view at the current magnified location, even if 
the mouse was not initially visible on the display. When disabled, your 
view moves to the location of the mouse. 
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Line-Lock 

When checked, the mouse will move only in the horizontal and vertical 
directions. If you move the mouse in a diagonal direction, MAGic moves 
the mouse in the closest direction. 

Auto-Switch  

When this check box is checked, centered and relative mouse tracking 
remain still after you stop mouse movement. The screen is stationary as 
long as you move the mouse within the boundary of the screen. When 
you move beyond the edge of the screen, tracking movement begins 
again. Auto-switch is useful when you want to move the mouse toward 
stationary objects on the screen. 

View Properties 
From the Magnification menu, choose View Properties to customize how 
the Split, Lens, or Overlay magnified views appear on your screen. 

Split View 

The Split tab allows you to define properties for the Split view. Split 
view allows you to see both an unmagnified view and a magnified view 
at the same time. The Split view opens a magnified window in part of 
your screen, but leaves the other part unmagnified as a reference. 

33 



Position 

Select where you want the magnified portion of the split to appear on 
the screen. Select Bottom, Top, Left, or Right. 

Size 

Select how much of the screen you want the magnified portion of the 
split to occupy. For example, if you select Quarter, the magnified 
portion of the split occupies 25% of the available screen area. 

If you select Line, the magnified portion of the screen occupies a size 
equal to one line of text, as specified in the Point Size field of the 
Panning dialog box. By default, Custom size is equivalent to one-third of 
the screen, but you can resize the split by using the Resize View button. 

Color 

Select from one of sixteen different colors for the border of the split 
divider. 

Thickness 

Move the slider bar to increase or decrease the thickness of the split 
divider. The bars above the slider indicate the widths you can select. 
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Lens 

The Lens tab allows you to define properties for the Lens view. Lens 
view opens a small rectangular window, which is magnified, while 
leaving the remaining desktop unmagnified. The lens moves around the 
screen as you move your mouse or when the focus changes. 

Color 

Select from one of sixteen different colors for the border of your lens. 

Thickness 

Move the slider bar to increase or decrease the thickness of the lens 
border. The bars above the slider indicate the widths you can select. 

Resize To Control 

Select this check box to resize the Lens view to exactly fit the control 
that currently has focus. The feature is useful when navigating with the 
keyboard. As you press the TAB key to move through a dialog, the lens 
changes size to fit the control with focus and MAGic magnifies the area. 
The border, if you have set one, surrounds the control. If you navigate 
with the mouse, the lens remains the standard size. 
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Overlay 

The Overlay tab allows you to define properties for the Overlay view. 
Overlay view creates a magnified window in the corner of the screen, 
while the rest of the screen remains unmagnified. This is similar to the 
Lens view, but the Overlay view does not move around the screen. 

Color 

Select from one of sixteen different colors for the border of your 
overlay. 

Thickness 

Move the slider bar to increase or decrease the thickness of the border. 
The bars above the slider indicate the widths you can select. 
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Locator 
Activate the Locator dialog from the Magnification menu. Here you can 
set the style of the Locator you want to use. To activate the Locator, 
press the Locator button on the MAGic user-interface. 

When you activate the Locator, the full screen is temporarily presented 
unmagnified. The default Locator is the Full Cross, which shows an area 
in inverse colors. Move the Locator around using the mouse or the arrow 
keys, and use the Locator to find something on your screen. Press the 
arrow keys to move around the screen. Use PAGE UP to move to the top 
of the screen, PAGE DOWN to go to the bottom, HOME to go to the 
beginning of a line, and END to go to the end of a line. After you have 
located the item, press the left mouse button, or ESC to return to your 
magnified display. The area you covered last with the Locator is now in 
your magnified view. 

Style 

Choose from three different styles for your locator: 

Full Cross – Shows a portion of the screen in reversed colors. In 
magnification 3x or higher, the Locator appears with crosshairs running 
through the center of the block. With magnification set to 2x the Locator 
appears as a block of inversed colors. 

Eyeglass – Shows a square on the screen that is magnified while the 
rest of the screen is normal size. 
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Reverse Eyeglass – The same as the Eyeglass, except the colors are 
reversed. 

Border 

Specify what kind of border you want to appear around your Locator. The 
customizable border only applies to the Eyeglass and the Reverse 
Eyeglass options. Choose one of the sixteen available colors for the 
border of your Locator. 

Color 
MAGic lets you invert the colors of your screen. You can invert the 
magnified image, the unmagnified screen, or both. Your choice of 
inverted areas will apply regardless of your selected magnified view. 
Select Color from the Magnification menu to specify your colors. 

Inverse Display – Select this check box to invert the colors that are 
displayed on your screen. Then specify the areas to invert with this 
option activated. 

Magnified View Only – Magnified images are inverted, while 
unmagnified views are unchanged. 

Unmagnified View Only – Only the unmagnified view is inverted, while 
all magnified views appear unchanged. 

All – The display is always inverted including magnified and 
unmagnified views. 
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